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WHAT IS ONENOTE? 

Microsoft's OneNote is a digital notebook that provides a single place where you can collect all 
your notes and information. The program delivers the flexibility to gather and organize text, 
pictures, digital handwriting, audio and video recordings, and more — all in one digital notebook 
on your computer. 

OneNote can keep the information you need at your fingertips and therefore reduce the time 
spent searching for information across e-mail messages, paper notebooks, file folders, and 
printouts. 

GETTING STARTED WITH ONENOTE 2010 
Explore the OneNote Interface 
If you are an Office 2010 or Office 2007 user, the first thing that you will notice is the familiar 
Ribbon interface. The Ribbon consists of three basic components Tabs, Groups, and Commands. 
There are seven tabs by default and each tab has several Groups of related items including 
Commands.  

When you first open OneNote, an example notebook opens that contains some information and 
examples about how you can use the application. 
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Screen Layout 
OneNote organizes your notes in a notebook, each of which is broken into a hierarchy of Section 
Groups and Sections consisting of page(s). All notebooks are located on the left side, with 
sections on the top as tabs, and pages listed on the right side. 

At the top of the screen is the familiar Title bar, displaying the notebook's name "What's New" 
and the applications name OneNote. In the upper right corner of the screen are the buttons 
minimize, maximize/restore, and close, which closes the entire application. 

To the left of the Title bar is the Quick Access Toolbar, which provides quick access to some of 
the most popular commands.  

Three of the most popular are: 
• The Back button allows you to navigate back to a prior page, 
• The Dock to Desktop, docks OneNote to the side of your desktop, useful when taking 

notes in another application 
• The Full Page View allows you to view the note in full page view 

You can also add additional commands to the Quick Access Toolbar 

How to: 
1. Right click on any Tab or Group and then click on “Customize Quick Access Toolbar.”  

Or 
Click on the down-arrow located on the Quick Access Toolbar and then the menu More 
Commands. 

2. Using either method will open the Word Options dialog box. When the box opens, click 
on the down arrow under the label "Choose commands from." Select from the options 
provided to add additional commands. 

Quick Tip:  
Right-click on any command button located on a tab or group to add that command to the Quick 
Access Toolbar. In addition, to remove a command from the Quick Access Toolbar, right click 
the command and choose “Remove from Quick Access Toolbar.” 

Backstage View 
The Backstage view contains mostly file related commands for 
working with notebooks, including information about the notebook's 
location and sync status. To access this view click on the tab File to 
access the following commands: 

• Open an existing notebook 

• New creates a new notebook 
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• Share a notebook with someone or a group 

• Save as another document type 

• Send using E-mail 

• Print  

• Options, pertaining to OneNote 

Click on any tab to close this view. 

Navigation Pane 
On the left is the Navigation Pane, which displays all save notebooks.  

• To view only the notebook that you are working on click the up 
arrow to hide all unwanted notebooks.  

• To hide the Navigation Pane, click the left arrow to the right of the 
menu "Notebooks" to collapse. 

• To reorder a notebook's placement in the pane click and hold on 
the notebook's title, then drag and release the mouse button at the 
desired location. In the screenshot above the indentations below the 
title, represent Sections Groups and Sections within the notebook, also visible as tabs.  

Page Pane 
Located on the right side of the screen the Page pane displays the current notebook’s page 
headings.  

• To hide the Pane, click the right arrow to the right of the menu "New Page" to collapse 
the tabs  

• To reorder a page's placement in the pane click on the page title, then drag and release 
the mouse button at the desired location.    

ORGANIZING AND WORKING WITH ONENOTE CONTENT 

Before you begin 

Determine what the notebook will contain to avoid rework, as some projects consist of large 
amounts of data and may need its own notebook. In addition, consider if you will share your 
notebooks and collaborate in real time with other OneNote users. 
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Create a Notebook 
To create a new notebook click on the tab File and then New.  

Complete the next three steps: 

 Web Network My Computer 

1. Where will the notebook       
     be stored? 

   

2. Name the Notebook Name Name Name 

3. Location: Windows Live SkyDrive 
Sign in with your new user ID 
and password. 

(LAN Network) do not 
confuse with Royal Drive 

Click the Browse button to 
select a location other than 
the default 

Click the button Create Notebook and the notebook now displays in the Navigation Pane with 
one New Section and a Page to hold data. However, Section Groups if desired are created by the 
user and do not contain any data nor can a page be added to a Section Group. In addition, Section 
Groups are automatically arranged in alphabetical order and in order to have control of that order 
consider adding a number before the title.  

How to:   

• Rename the section  
Right click on the tab New Section 1 and choose Rename or right click on the heading 
New Section 1 in the Navigation Pane, then choose Rename. 

• Name the Page  
At the top of the page, type a title in the text container (dotted heading). The page title 
also appears on the page tab. 

• Insert a Page 
Click the New Page button above page tabs column (Click the arrow next to the New 
Page button to choose a blank page, to create a subpage in a page group, or to create a 
page from a template.) Name the page. 

• Reorder the Page  
In the page tabs column click and hold the mouse button down on the desired page to 
move. Drag the page to the new position then release the mouse button. Alternatively, 
right-click on the page title and choose Move or Copy from the shortcut menu. When the 
Move or Copy dialog box opens select the desired Notebook, Section Group, or Section 
and then click the appropriate button. 

Note: To move or copy to an existing Notebook that notebook must appear in the Navigation 
Pane. 
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Organizing Your Notes 

Begin by creating Section Groups or Sections within a notebook for whatever you need to track; 
Tasks, Meetings, etc. Organize your notes in the related sections and add additional pages as 
needed. 

Creating Notes 

It's easy, just click anywhere on the page that you want the notes to appear and start typing. You 
can continue to keep typing within the current note container, or click elsewhere on the page to 
create a new note container.  

Notes can include any combination of typed text, pictures, and graphics — including text and 
images you collect from the Web pages — as well as digital handwriting, audio and video clips, 
and more. 

If you prefer to use a pen-input device, just click the tab Draw on the ribbon and then click on a 
pen color in the Tools group to handwrite your notes anywhere on the page. To switch back to 
typing at any time, click the Select & Type button on the Draw tab on the ribbon. 

Create Template-Based Notes 
1. Create or open an existing page that you want to save as a page template. 
2. In the right pane, click the downward arrow next to New Page, and then click Page 

Templates. 
3. At the bottom of the Templates pane, click Save current page as a template. 
4. Type a name for the page template, and then click Save. 

Formatting Notes  

The notes page is the work surface where you take and collect notes within a notebook. You can 
format, move, resize, and even merge notes containers on the pages in your notebook. 

How to:  
Basic formatting commands 

1. Click the Home tab  
2. Click on the notes container to format the entire contents, or select the text within the 

container to apply formatting styles. 

Move text on a page 
1. To move text within the same page, move the mouse pointer over the text. When the note 

container appears, click the top edge of the note container, and then click and drag the 
container to a new location on the page. 

2. To copy or move text from one page to another page, right-click the top edge of the note 
container, click Copy or Cut on the shortcut menu, and then paste the notes to the page 
you want. 
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Merge notes containers 
1. Click on the move handle of the notes container that you wish to merge. 
2. Hold the Shift key and mouse button down. 
3. Drag the selected container over any notes container on the same page. 
4. When the contents are merged, release the mouse button first and then the Shift key. 
5. Use the keyboard shortcut (Ctrl+Z) to undo the merge. 

 

Draw Shapes 

The new and improved drawing tools in OneNote make it easy to mark up text and items that 
appear on your pages. In addition, they are powerful enough to create organizational charts and 
flow diagrams. Click the tab Draw to view the Draw Toolbar. 
How to:  
Select the Line Color and Thickness 

• Lines you draw can vary in thickness and color. Before drawing, make sure that the 
thickness and color are set to your preferences. Click the Color button on the Draw 
toolbar to select a color, and click the Thickness button to select a thickness (in points). 

Select a Pen 
• OneNote’s selection of pens from the Pen drawing tool works for just about everything 

you want to draw, so instead of setting the color and thickness first, consider going 
straight to the Pen tool. Notice that the list of pens includes color highlighters (the lower 
half of the pop-up pen selection list). 

Draw and Highlight 

• After selecting a pen or line thickness, select the tool shape that you want to draw. You 
can draw a line, an arrow, a rectangle, an oval, a triangle, and other shapes. Click a shape 
to select it, and then drag your mouse where you want to put that shape onto your note. 
The shape appears on your drawing using the pen or color and thickness you selected. 

Lasso to Select a Shape 

• After placing a shape, you can resize or move it. Selecting a shape that shares the same 
space in your notes as text is difficult and requires using the Lasso tool. Click to select the 
Lasso tool, and then drag to circle whatever shape you want to select. OneNote selects 
that shape and adds sizing handles around it. You now can resize and move the shape or 
press Delete to delete it altogether. 

INTEGRATING ONENOTE WITH OTHER APPLICATIONS 

Using OneNote with Outlook 

Sending E-Mail Messages to OneNote 

To send a copy of an open e-mail message from Outlook to OneNote, follow these 
steps: 
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1. Open the message that you want to send. 
2. In the Ribbon of the open message window, click the button Send to OneNote in the 

group Move. 
3. When the Select Location in OneNote dialog box opens, choose a notebook and then pick 

a section or page to place in the email. 

To copy one or more closed messages, follow these steps: 
1. In any Mail view, select the message or messages you want to copy. Hold down the 

[CTRL] key to select multiple messages. 
2. Click the button Send to OneNote in the group Move.  

Insert Meeting Details into a Note 
If you use OneNote to take notes at meetings, the ability to insert meeting details into a note 
comes in handy. OneNote automates this task for you as much as possible, as you will see when 
you follow these instructions: 

1. Start in the OneNote note where you want to include meeting details. 
2. Position the cursor at the location where you want the details to appear. 
3. Click the button Meeting Details on the Home tab in the group Outlook. Not the meeting 

you are looking for, then click the command “Choose a meeting from another day.” Use 
the Previous and Next arrows to locate the meetings date. 

4. Select the meeting and then click Insert Details. 

Send an OneNote 2010 Notebook to Outlook, Word, or a Blog  

OneNote’s powerful integration with other applications affords 
the user the ability to send and view notebook pages in Word, 
Send to Outlook, or Publish to a Blog.  
 
Note:  You cannot send an entire notebook to Word, Outlook, or 
as a PDF attachment.  

Send to Outlook 
Follow these steps to email a notebook page, send as an 
attachment, or PDF. 

1. Start OneNote 2010, if the application is not already 
open and then select the desired notebook. 

2. In the notebook, select the page or pages in the desired section. To select multiple pages, 
hold the Ctrl key down and select the pages. Release the key. 

3. Click the tab File and then Send, to choose from the option listed. 
o E-mail Page – sends a copy of the selected pages embedded in an email 
o E-mail Page as Attachment – sends a copy of the selected page in the original 

format as an attachment in OneNote format. 
o E-mail Page as PDF – sends the selected pages in PDF format as an attachment. 



 8 

Send to Word 
1. Assuming that OneNote is open select the desired notebook and then the page or pages 

within that section. To select multiple pages, hold the Ctrl key down and select the pages. 
Release the key. 

2. Click the tab File, Send, and then Send to Word.  
3. The selected pages are sent to a Word document. 

Send to Blog 
1. Assuming that OneNote is still open, select the desired notebook and then the page or 

pages within that section. To select multiple pages, hold the Ctrl key down and select the 
pages. Release the key. 

2. Click the tab File, Send, and then “Send to Blog.” If you 
have not registered your blog account, you are prompted to 
Register Now or Register Later. Either way the selected 
page is imported into Word activating the On-Demand tab 
Blog Post. 

Managing your Blogs 
1. Click the command Manage Accounts in the group 

Blogs. 
2. Click the button “New” on the Blog Accounts 

dialog box. 
3. Click the down arrow in the New Blog Account 

dialog box and choose your provider. In the 
example, I selected Word Press. 

4. In the next box, type your blogs URL in the space 
provided <Enter your blog URL here>. 
Example – wmlstaff.wordpress.com -> 
http://wmlstaff.wordpress.com/xmlrpc.php 

5. Type your username and password in the 
spaces provided. Before clicking on OK, 
consider your Picture Options. 

6. Click the button Picture Options to define 
where your pictures will be stored or not. If you 
choose “My own server,” you will need to fill 
in the proper locations in the box below.  
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Saving OneNote 2010 Notebooks and Pages in Other Formats 

OneNote allows the user to save the current notebook and pages in multiple formats, which is for 
the distribution of notes to someone who does not possess the OneNote application. 
How to: 

1. In OneNote, select the notebook that you would like to convert and save in a different 
format. 

2. Click the tab File and then Save As.  
3. Saving the current selection Page, Section or as a Notebook determines the file format.  
4. The user then selects the file type under the format listed for the selection.  
5. Click the button Save As to save in the selected format. 

Publish Note Pages as a Web Page 

Although you can save a notebook section or page as a web file, this would not be my selection. 
The selected section or page saved as a Microsoft MHTML document is only readable in 
Internet Explorer. The program has no FTP program to transfer the page to a web server. 

Note: The only formats for saving an entire notebook are (1) OneNote package – notebook 
packaged in the original format for distribution, (2) PDF – Portable Document Format, free 
reader available, and (3) XPS – Microsoft’s version of a pdf file. 
 

L inked Notes with Word and PowerPoint 

Start a Linked Notes session 
You can begin taking linked notes about a Web page, Word document, PowerPoint presentation, 
or OneNote page that you are looking at by doing the following: 

1. On the Ribbon in Word, PowerPoint, or OneNote, click the tab Review. 
2. In the group Notes, click the button Linked Notes. 
3. In the Select Location in OneNote dialog box, navigate to the notebook, section, and page 

where you want to take notes about the document or page that you are looking at, then 
click OK. 

4. Take notes as you normally would. You can bring up other OneNote pages in the main 
program window, bring up Internet Explorer, or open additional Word or PowerPoint 
documents. OneNote automatically links back to what you were looking at so you can 
easily refer to the source material again later. 
 

 Note: Another way to take linked notes in OneNote is to click “Dock to Desktop” command 
located on the View tab or the Quick Access Toolbar. The current OneNote page will be docked 
to the side of the Windows desktop, where it will stay visible while you use other programs. Any 
notes that you take in the docked OneNote window will be linked to their context. 
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Finish a Linked Note Session 
You can end a Linked Notes session by doing either of the following: 

• Click the button Dock to Desktop on the quick access toolbar to undock the window and 
toggle Linked Notes mode off (or simply press CTRL+ALT+D). 

• Click the button Normal View on the Quick Access Toolbar or View tab. 

View or remove note links 
When in the mode Linked Notes, a button with a chain link displays near the top left corner of the 
docked notes page. When engaged in a Linked Notes session hover the mouse pointer over any 
individual note on the page to see which notes are linked. 

Hover the mouse pointer over any of the application icons that appear on the page to display 
thumbnail images of any Word documents or PowerPoint presentations; OneNote notes pages, or 
Internet Explorer Web pages that the notes are linked to. You can click any of these thumbnail 
images to open their associated files. 

Quick Tip: To see a list of all of the documents that are linked from the current page, or to 
remove any links that you don't want, click the chain link icon in the top corner of the page. 

BROWSER INTEGRATION 
 
Internet Explorer 

Sending text, pictures, and video from 
a web page to OneNote is easy. In 
Internet Explorer, select the desired 
content with your mouse pointer, right 
click, and select Send to OneNote.  
 
This will open the Select Location in 
the OneNote dialog box. Select the 
desired notebook, section, or page. 
Click OK.  
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FireFox 

Firefox does not support OneNote on its own and requires an extension called Clip-to-OneNote 
(https://addons.mozilla.org/en-US/firefox/addon/clip-to-onenote/). After installation, click on 
Tools, Add-ons and then Options in 
the Firefox browser. Specify the path 
of the OneNote exe. file in the 
OneNote Path dialog box. Click OK. 
 
In Firefox, select your text or right 
click on the content to send to 
OneNote. Select Clip to OneNote. 
 
In OneNote, move the current page to 
the desired notebook, section, and 
page. 
 
 
EXTRACT TEXT FROM AN IMAGE 

One of OneNote’s many features includes OCR (Optical Character Reader), the ability to 
recognize and extract text from any image file format. Text extracted from an image can be 
pasted anywhere on an OneNote page. 
 
How to: 

1. Drag and drop or insert an image file containing text into an OneNote page. 
2. Right-click on the image, and Copy Text from Picture. 

3. Paste the text anywhere you like on the OneNote page. 

Note: Small text or text that contains symbols may not extract properly. 

 
INSERT ATTACHMENTS 
 
Inserting attachments in OneNote allows the user to collect and organize related files in one 
notebook.  

How to: 
1. In an open notebook, click the tab Insert and then Attach Files in the Files group. 
2. Within the “Choose a file or set of files to insert dialog box” select a file to insert and 

then click Insert. 
3. The file is inserted displaying the associated icon and name for the file. Double click on it 

to open. 
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INSERT TABLES 
If you use tables, OneNote also provides that option. 
 
How to:  

1. Open an OneNote notebook, and then on a selected page place the cursor where you 
would like the table.  

2. Click the tab Insert and then Table from the group Tables.  
3. Hold and hover the mouse pointer to select the desired number of columns and rows 

required. Release the mouse button. 
    OR  
Click the command Insert Table, and then enter the number of 
columns and rows in the box provided.  

4. Click OK. 
 

 
RECORDING AUDIO AND VIDEO 

OneNote users who have access to a microphone and 
web cam have the ability to record audio and video 
files to supplement their notes.  

Audio & Video Settings  
Before attempting your first recording, consider 
verifying your audio and video settings in the OneNote 
Options. Click on the tab File and then Audio and 
Video.  

How to:  
Record Audio 

1. Open an OneNote notebook, and then on a selected page place the cursor where you 
would like the audio inserted. 

2. Click the tab Insert and then Record Audio in the group Recording. A description box 
will be inserted with an icon displaying the date and time of the recording. 

3. When you stop recording, a Playback tab appears providing the user with Playback and 
Rewind options. 

Record Video 
On the same tab Insert, click the Record Video button, then click in the desired location to 
start recording. 
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SCREEN CLIPPING WITH ONENOTE  
 
With the Office 2010 tool Screenshot, you can take a picture of any part of your computer screen 
and insert the picture into your notes. The tool is built into most Office 2010 applications 
including OneNote. 
How to:  
There are two ways to take a screen clipping to insert 
into an OneNote notebook. 

1. With OneNote minimized in the background, 
verify that you are viewing the webpage or 
screen that you would like to clip. 

2. Press the [Windows key+S], and then 
holding the mouse down draw a box on the 
part of the screen you would like captured. 

3. Release the mouse button, and the OneNote 
dialog box will open. 

4. Select the desired notebook and section. Then 
click the button Send to Selected Location.  

OR 
1. Minimize all screens except for the one you want to capture and your OneNote notebook. 
2. In the desired section of the notebook click the tab Insert, and then Screen Clipping in the 

group Images. 
3. At this moment, OneNote minimizes and you are returned to a dimmed version of the last 

screen you looked at. 
4. Holding the mouse down draw a box on the part of the screen you would like captured. 
5. Release the mouse button, OneNote captures the selection as a picture and inserts it into 

your notes page at the position of the cursor.  
 

OneNote also copies the image to the Windows Clipboard so you can paste the screen clipping 
on another page in your notebook or into any other program or document. 
 

COLLABORATING AND WORKING WITH NOTES 

Sharing Notebooks on a Network Location  

This option is not available without access to a LAN server and does not apply to sharing in 
Royal Drive. However, sharing notebooks should be possible after the email transition to our 
University SkyDrive account. 

Working with Shared Notebooks 

Share an existing notebook 
1. On the File tab, click Share. 
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2. Under Select Notebook, select an existing notebook that you want to share with other 
people or between other computers that you will be using. 

3. Under Share On, click Web so you can use the notebook from any computer or from a 
Web browser. 

4. Choose the Location, in this example it would hosted on Window Live Account 
(SkyDrive), later on Live@scranton.edu. 

5. If Live@scranton.edu is available, sign in with an existing account (such as Windows 
Live, Hotmail account) or sign up for a new one. After signing in, you will see a list of 
your Web folders where you can create shared notebooks.  

If you don't need to share with other people, select one of the Personal Folders. If you do 
need to share, select a Shared Folder to which others will have access. To set sharing 
permissions for new and existing folders, OneNote will launch your Web browser, where 
you can finish creating the new folder for your notebook. Return to OneNote and then 
refresh the folder list in the Web Location field to see the folder that you just created.  

6. Click Share Folder. 

Sync Status  

Notebooks that are shared on the Web require synchronization between the actual copy stored on 
your computer and the one residing on the web.  
 
You can access the sync interface by right clicking on the name of a shared notebook on the 
navigation pane and click on Notebook Sync Status on the shortcut menu. Another method is to 
click the ribbon tab File and then click the View Sync Status button that appears on the Info page. 

To synchronize all notebooks, click 
the Sync All button at the top of the 
right corner of the dialog box.  
 
To synchronize only specified 
notebooks, click the Sync Now button 
in the list next to the notebooks you 
want. 
 
Note: When you click the little 
triangle that appears to the left of a 
dimmed notebook icon in the list, 
additional details about the 
synchronization status of that shared 
notebook are displayed. 
 


